
Importing and Exporting DWG and DXF in MiniCad and 
VectorWorks

Introduction
The following is based on our common experience and MiniCad 7 and VectorWorks manuals (MiniCad and VectorWorks are 
products of Diehl Graphsoft, Inc.) . We highly recommend for further reading the article by Dave Weber, DXF Made Easy, 
available at:

http://www2.portal.ca/~wmw/dxf/dxfme.html

Although WeberÕs article was written at the time of MiniCad 6, it is nonetheless thorough, informative, and useful.

What we should stress first and foremost is that DWG and DXF (the former in particular) are proprietary formats and 
subject to change over time. In addition, features of one software platform (such as MiniCad or VectorWorks) are not 
necessarily implemented on another (such as AutoCAD). As a result, as with any translation, importing and exporting via 
these ÔuniversalÕ formats is imperfect at best, and results can be quite variable, depending on the version of a drawingÕs 
native application.

While we attempt to cover the basic mechanics of file translation, there are so many dialects and nuances of DXF and 
DWG, that only experience will allow for smooth translations, and imperfection is inherent to the process. That said, 
VectorWorks 8 (thanks in large part to Diehl Graphsoft, Inc.Õs membership in the OpenDWG Alliance) makes great strides 
in bridging the inevitable gap between MiniCad and DWG. For the sake of thoroughness, we will cover both MiniCad 7 and 
VectorWorks 8.

Importing to MiniCad 7
Before importing a file, it is important to communicate with the exporter (the person from whom you are getting the file, 
who is probably an AutoCAD user). You should do the following:

A Let the exporter know what file format and version you need. MiniCad 7 reads up to AutoCAD version 
13 DXF and DWG. Note that DWG is a more efficient file format (generating smaller files) and equal 
to DXF in terms of compatibility, but DXF files reportedly compress to a slightly smaller size than 
DWG, in spite of being much larger uncompressed.

B Have the exporter include a graphic scale in the drawing. Surveys especially (due to surveyorsÕ use of 
decimal feet instead of feet and inches) are frequently off. You may need to scale the entire file up 
(typically by a factor of 12 in the case of surveys) or down.

C The exporter must not use paper space (an AutoCAD device which achieves similar results to 
MiniCadÕs use of scaled layers and layer links).

D The exporter must eliminate ÔcometsÕÑtiny fragments of drawing miles way from the main drawing 
area. These may creep in to your drawing later once youÕve imported it (see below).

E The exporter must purge any unused/unnecessary blocks and unused/unnecessary layers . Ask the 
exporter to perform multiple consecutive purges in order to remove nested blocks.

F If the file is really important, ask for hard copy or image to accompany it.

Once you have the prepared file:

G Open a new, blank file. 
H Set the scale and page size to match in the original you are importing.
I From the Edit menu, select the Edit Attributes command, Dash Styles..., and delete all except 

dash style #1. (You could create a stationery file after steps G-I in order to avoid having to repeat them 
for every import. You can also include your standard set of classes in such an importer template).

J Go to the File menu. Selecting the Import DXF/DWG  command will result in the opening of a 
navigation dialogue box; choose the DWG or DXF file you wish to import. You will then see:
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Generally, it is recommended to select the first option. Choose the second option only if you are using 
the file only for 2D information, and do not wish to import any 3D information.

K Check the scale of the imported file against that of the original (by selecting an object whose 
dimension(s) you know and verifying them in the Object Information palette).

Finally, you will need to adjust the file to fit your needs:

L This may involve going through the file layer by layer, selecting all (with Organize menuÕs 
Layer Options NOT set to Show/Snap/Modify Others ), and ascribing one of your standard 
classes to the imported layer. Remember that AutoCAD layers correspond more closely to MiniCad 
classes.

M Delete stray ÔcometsÕ, using the Page menuÕs ViewBar command, Fit to Objects (command-6) to 
locate them.

N At this point, you might want to group all the contents of each of the imported layer, in case you need to 
modify them globally at some later point.

O You may also use Julian CarrÕs reLine commands to change imported objectÕs colors and line weights to 
match your own standards (http://www.zeta.org.au/~jbcarr/).

Once the file is reduced to a set of groups whose contents are set to appropriate classes, colors, and line weights, you may 
then set the Organize menuÕs Layer Options  to Show/Snap/Modify Others , Select All , then Group . 
The new single-layer group may then be cut and pasted into your standard template-based file.

Exporting from MiniCad 7
Just as when you import a file from another platform the user of that platform must prepare the file, so too must you 
prepare your file for export before actually shipping it off. Again, communication is the key. Talk to your audience and find 
out exactly what information the user needs; purge any irrelevant information. You, the exporter, should do the following:

A Save your file under another name. Perform the following steps to the renamed file.
B Delete all irrelevant layers, classes, and symbols. Delete your title block if possible and desirable.
C All layers should be at the same scale.
D Select All and Ungroup, except for Ôhigher level objectsÕ, such as walls and dimensions.
E Set all line weights to 1 mil (or .03 mm). This may involve either editing each of your symbol 

definitions individually, or converting all your symbols to groups (which will result in a larger file), 
then converting line weights en masse . WeÕve experienced situations where converting all line weights 
to 1 mil seemed to make translation go more smoothly; other times, it didnÕt seem to matter.

F For good measure, change all fill attributes to none. You will now see what your recipient will see.
G Change all text to left justified and Arial, Geneva, Helvetica, Times, or Times New Roman.
H Convert all symbols with attached record format information to groups.
I Purge Unused Objects... from the Edit menuÑseveral times (four is a good rule of thumb), 
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depending on how ÔdeepÕ you make your nested symbols.

Once you have done the above, and are actually ready to export:

J Go to the File menu, Export DXF/DWG command. You will see this dialogue box:

Usually, you will want to export by class (remember that AutoCAD layers correspond more closely to 
MiniCad classes), depending on how you use classes, layers, and colors. Choose whether to export 2D 
and 3D objectsÑagain, provide the least information necessary to minimize bandwidth and reduce 
chances of importation failure. Decide whether to export as DXF or DWG. DWG is a more efficient file 
format (generating smaller files) .

K Name the export using DOS conventions: eight-character names, maximum, no spaces or special 
characters, followed by the .DXF or .DWG file extension as appropriate.

L Re-import your file back into your MiniCad importer template, just as a check. If you have another 
CAD program available, use it. Use the same procedures as outlined in the section above.

Importing to VectorWorks 8
Generally, the same preparation is required for import to VectorWorks as MiniCad (or any other CAD program).

A VectorWorksÕ multiple undo feature generates an undo history; importing a DWG or DXF clears the 
history and is therefore not undoable. Hence:
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Click OK. Several progress bars appear as VectorWorks examines the file to be imported and loads it.
B You will then see the following dialogue box. Under the Units and Scale tab, in all likelihood you will 

want to select the DXF/DWG units to 1Ó or 1Õ for surveys and other decimal-feet files. Set the scale 
manually if you know or can guess it (and you have already set the scale of Layer-1 in your template 
file); otherwise let VectorWorks choose a scale for you.

C Under the Conversions tab, you may select whether to import the DXF/DWG layers as classes and 
whether to treat all XY plane-parallel object as 2D. MultiLines are non-MiniCad/VectorWorks; you 
must choose whether they are to be translated as walls or polylines, depending on their use in the 
original file. Generally, you should choose to preserve the document look, and convert DWG points to 
loci, unless you want them to print. DWG-based programs like AutoCAD use rays and construction lines; 
you may elect to import these as lines.
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D If you choose to map colors to line weights, you may designate line weights to correspond to line colors 
of the original document; especially useful if you know what line weights the exporter typically 
assigns to which pen colors.

Importing and Exporting DWG and DXF in MiniCad and VectorWorks Fran�ois L�vy and Adam Pyrek
page 5 of 8 June 1999



Exporting from VectorWorks 8
You will need to prepare your file for export under VectorWorks just as you should for MiniCad 7. You may not need to 
convert line weights to 1 mil, however, if you map colors to line weights (see below). Once you have done the above, and are 
actually ready to export:

A Go to the File menu, Export DXF/DWG command. You will see this dialogue box:

B Select your file format based on the recipientÕs requirements. Remember that DWG is a more efficient 
file format (generating smaller files) and only slightly less compatible to DXF in terms of MiniCad or 
VectorWorks compatibility, but DXF files reportedly compress to a slightly smaller size than DWG, in 
spite of being much larger uncompressed. If the recipient is not using AutoCad, use DXF unless you know 
that DWG is acceptable.

C Export either 2D or 2D and 3D information, again based on your recipientÕs needs.
D Map line weights to colors if you use pen color to designate line weight. Generally, AutoCad users 

employ line color 7 (white) to represent invisible lines, with the following colors (in order) 
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representing gradually heavier lines: red (1), yellow (2), green (3), cyan (4), blue (5), etc. Be sure to 
include a text file which correlates colors with your line weights.

                    

E Converting classes as DXF layers typically is desirable if you use classes like AutoCAD uses layers.
F You can avoid some of the preparation work merely by turning off layers and classes you do not wish to 

export and selecting the appropriate options shown above.
G Name the export using DOS conventions: eight-character names, maximum, no spaces or special 

characters, followed by the .DXF or .DWG file extension as appropriate.
H Re-import your file back into your VectorWorks importer template, just as a check. If you have another 

CAD program available, use it. Use the same import procedures as outlined in the section above.

Known Problems
MiniCAD 7 sometimes drops objects, particularly polylines. If you have a copy of MiniCad 6, you may get a more stable 
DXF v12 export, but you cannot export to DWG or a more recent version of DXF. Converting all line weights to 1 mil is often 
helpful in working around this problem.

VectorWorks  8 will rarely fail to export altogether. This seems to happen due to corruption of a MiniCad 7-generated 
polygon. To find the bad object, try to export half your file at a  time. When it fails, try exporting half of the half, and so 
on, until you isolate the culprit. You may also at times get a low memory message, which may not actually be a function of 
insufficient memory. Finally, avoid ÔcometsÕ in your file to avoid an Ôelements out of rangeÕ error; keep all your objects on or 
near the sheet area.
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Two-way exchanges
We do not recommend maintaining an ongoing  back-and forth from one software platform to another over the course of a 
project. DXF and DWG translation is really only suited for providing backgrounds. If you must collaborate with another 
user on another platform, and regularly trade files, at the very onset of the project you will need to develop a collaboration 
methodology :

A Decide on a common exchange format: DXF or DWG, v12, 13 or 14.
B Decide on a method for sending files: FTP server, Zip disk, email attachments. We strongly recommend 

the first.
C Commit to supplying backgrounds only when feasible. DonÕt make promises that inherent limitations of 

the technology might make you unable to keep later.
D Limit and control the exchange of symbols and title blocks.
E Decide on a single, site-based reference point and include it in all the drawings; label it. Include a 

graphic scale.
F Know the limitations of DWG and avoid or control using unsupported elements.

1 Walls, for example, will export, but only as lines or polylines, not hybrid elements.
2  Symbols will export as blocks, but only 2D or 3D, depending which view you are in at the 

time of export.
3 Worksheets and layer links are totally unsupported in DXF or DWG. (You may manually 

copy contents of source layers into target layers to preserve the effect of a leyr link, 
however).

4 Record formats will transfer, but only if you convert the record format bearing symbol to 
group first.

5 Any textures applied in RenderWorks will not carry through, although if you assign 
material-specific classes to your objects, those classes will go across as DXF layers, to 
which the recipient may assign colors or textures if the other platform supports it.

In fact, many of the features that make VectorWorks or MiniCad particularly powerful are lost to 
DWG or DXF; it truly is a Ôlowest common denominatorÕ format.
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